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1. ACCESS TO THE ECONOMETRIC SOFTWARE

In this primer we’ll use program g?‘e't/ (Gnu Regression, Econometrics and Time-series Library ;@ to

introduce the General Linear Regression Model (GLRM). Therefore, it is assumed that gi‘el‘/ ’s software has
already been downloaded from its official site at gretl.sourceforge.net and that all necessary steps to install the
software in your computer have been successfully carried out.

Please note: This guide refers to grez‘[ version 1.7.9 as of Sep 28, 2008.

In order to access grez‘[ :

“HH Desktop screen :  Double-click on the grel*/ icon A&

or...

Start = All Programs » -‘ gretl

2. LOADING AND SAVING DATA: THE MENU

In order to estimate a model you need data stored in a file. There are several methods in g7¢7/ to create and
handle this data file:

2.1. A new data set: If the data are simply on paper, you’ll have to type them into a grefl file. Let us consider
the following data set obtained from the strawberry production data experiment:

Obs 1 2 3 4 5 6 7
Y 40 60 50 70 90 80 100
X 10 25 40 45 60 80 90

You must introduce data by hand for the variables of interest: the dependent variable Y as well as the explana-
tory variable X (you may add more variables later on if you like):

® Cross Sectional
“T File |} New data set » Number of observations B © Time Series
© Panel

After entering data values for the first variable using grez‘/ ’s spreadsheet you may add a new variable and
carry on entering data for the second variable:

“T1  gretleditdata: Variable | Add

Once the data are introduced you should save them in a g?‘ez‘/ file:

“Bl File || Save data [cu+]s]

If the data have not been saved yet, a new pop-up window will open where you will be asked to provided a file
name (something like MyDataFileName.gdt for instance) and location within your directory structure. Next
time, the data will just be saved in the current file overwriting its previous contents.

2.2. An existent data set: Otherwise, if the data are already in a gre// file:


http://gretl.sourceforge.net/win32/
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“Bl  File |} Open data B Userfile. . [ero]

You must browse through the hard disk’s directories for the file you want and open it by clicking on it.

Note that if the data file has been used recently, you can also find it in a short list at the bottom of the options:

“1  File | Open data B <bottom lists. ..

2.3. Importing from non-gretl data sets: If your data are filed in a different format, like a plain and readable
CSV file or an Excel spreadsheet file for instance, you can import them into g?‘el‘[ :

“T1  File | Opendata » Import B <formatss...

You select the format type and browse for the file of your choice.

2.4. Textbook data sets: Also, g?‘ez‘l includes data files from some textbooks:

“P1  File |l Open data » Sample file. ..

For example, you may open data file 7.12 of Ramanathan’s bool]. This file contains 11 variables. If you are
interested in some of them only, you can generate a new data file containing just the variables of interest:

“T File || Save data as P Standard format. ..

Now you can select the variables you want to keep (say price, length, weight) and you save the file with a new
name like say Ram712 . gdt or any other of your choice. In the remainder of this guide we will be working with
the file you have just created.

2.5. Exporting to other formats: Note that, instead of saving your current data set to a g7e/ file type (x . gdt),
you can also export the data to a different format:

“B1  File |} Export » <formatss>. ..

As with the import option you select the format type and a file name. Later on you may work with the new
file with other software like, for instance, Excel.

3. MANIPULATING DATA: THE MENU

3.1. Data selection:
“P1 You may select the variable(s) with a single mouse click on g?‘ez‘l ’s central panel.

-ﬁfl If you want to select more than one variable hold the key down while selecting them.

Also, if you want to select all the variables in the data set at once:

“P  Data | Selectall

1 Additional collections can be downloaded from gi’ez‘/ ’s site.



J FDEZMACHO 5

3.2. Reviewing the data: To see the data entered into the current data set, first select the variables of interest and:

“P Data | Display values

You may check this with the file you created in the previous chapter by selecting some variables from Ra-
manathan’s data file 7.12.

(“B“E Short cut: just double-click the variable name on the central panel to review a single variable.)

3.3. Data correction: If you made mistake when entering some value. . .

“B1  Data |} Edit values

... will open g?’ez‘/ ’s spreadsheet where you may replace the wrong values with the new ones.

3.4. More values: If later on you have more observations for some (or all) of your variables. ..

“T Data |} Add observations. ..

... will ask you for the number of observations that should be added to the bottom of your data set. Of course
you’ll need now to open the grez‘[ ’s spreadsheet to enter the new values as for data correction.

3.5. Changing the structure: By default data are assumed to have a cross-sectional structure. To change it:

o Cross Sectional
“P Data |} Dataset structures » ® Time Series
o Panel

After this g?‘ez‘/ will allow you access to new commands specific for time-series data like time-series plots,
seasonal dummies, time-series models, etc. (they appear written with dimmed gray letters otherwise). Similarly,

o Cross Sectional
“M Data | Dataset structures B o Time Series
® Panel

will grant you access to specific panel data commands.

4. STATISTICS & GRAPHS: THE MENU
4.1. Main statistics:

a) Descriptive statistics:

“H View » Summary statistics

displays mean, median, minimum, maximum, standard deviation, etc. for the selected variables in the
central panel.

b) Correlations:

k/EI View P> Correlation matrix

opens a popup window to display correlation coefficients of the variables of interest.
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4.2. One-dimensional time-series plots: If the current data set has a time-series structure you may visualise the
evolution of one or more variables along time:

“F view » Graph specified vars B Time series plot. ..

By clicking on the graph a pop-up menu appears that allows you to do several things like saving your plot in
different formats or copying the plot to Windows clipboard for later use in, say, a Word file where it can be pasted
(with + ). For example, if you want to save the graph within the current session, select “Save to session
asicon”.

4.3. Two-dimensional scatter plots: More generally, you may want to plot pairs of variables, one against the
other, to visualise how they are related:

B View » Graph specified vars B X-Y scatter. ..

Clicking on the graph lets you save the plot, etc. exactly as before.

4.4. Three-dimensional graphs: A more complex type of graph lets you visualise how one variable may be
related to a combination of two other variables:

B View » Graph specified vars B 3D plot. ..

Note that, for obvious reasons, it is usually convenient to choose the dependent variable as the Z-axis variable.
The 3D graph can be rotated by clicking on it, which is nice, but it cannot be saved like the previous one. It can
nevertheless be printed or copied to the clipboard (with ) so that it can be pasted (with [ewHv] ) toa
Word file for example (right-click on window’s blue top to see gnuplot options).

4.5. The icon view: All these results saved in your session can be visualised as follows:

L4Ijl View P> Icon view

Note that most results (like summary statistics, etc.) are saved by g?‘ez‘[ automatically, while a few (like
graphs) will need an specific action by the user.

5. DEFINING NEW VARIABLES: THE MENU

Some simple but important transformations of existing variables can be easily obtained within g?‘ez‘[ itself,
for example

a) the natural logarithms:

‘Ml Add | Logs of selected variables

b) or the squares:

‘P Add |l Squares of selected variables

For time-series data there are some specific time-related transforms like:

a) the first lags (that is, the previous value of each period):

“Bl Add | Lags of selected variables
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b) the first differences (i.e., the change between one period and the next):

“B Add | First differences of selected variables

¢) or a secular trend (that is, like time itself):

“l  Add} Time trend

More generally, you may construct a new variable as a mathematical function of the ones already present in
the current data set:

“P  Add | Define new variable. ..

...opens a dialogue in which to enter a formula for the new variable. For example, if you type. ..

gretl:Add : Define new variable » length_m = 2.54xlength

...anew variable (1ength_m) will appear in the central panel corresponding to the car length in cm (instead
of inches).

The new variables thus created can be visualised by any of the means described above.

6. SINGLE VARIABLE RESULTS: THE MENU

This menu offers short cuts to all the commands that are relevant to single variables. The first one simply lets
you find and select a variable by name, which can be useful if your data set contains many variables:

“P  variable |} Find...

As for the rest, most of them have been already mentioned above whilst others have an obvious meaning:

Display values
Summary statistics
Normality test
Frequency distribution
“B1  Variable | Frequency plot. ..
Gini coefficient!} Lorenz curve
Edit attributes
Define new variable. ..
etc.

For example,. ..

“F1  Variable |} Edit attributes

... lets you modify the name of the variable, its description or its display name that appears in graphs.

7. ESTIMATING A REGRESSION MODEL: THE MENU

Estimation of a regression model is extremely easy with g?‘ez‘l :

“P1 Model » Ordinary Least Squares. ..
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...opens a menu where we can select the dependent and the explanatory variables from the current set:

i

- [O]x]|

oLs

const Qggendent wariable

Hifice == Choose -£ ‘un[e

length
el [ set as default

Independent wariables

<- Remave

[ Robust standard errors  configure
;‘_g_elp | rr:'l Cleat | %;ancel ‘ ﬂ oy |

% gretl: model 1

Fle Edit Tests Save Graphs Analysis LaTex ‘

Model 1: OLS estimates using the 82 cbserwvations 1-82
Dependent variable: price

coefficient  std. error  t-ratio p-walue

©onst 40,4537 12.5664 3.219 0.0018 FEE
weight 2.48090 0.290386 8.5435 7.58E-013 wF%
length m -0.202643 0.0414675 -4.887 5.27E-06 FF%

Mean of depent srariable = 18,1548
Standard deviation of dep. var. = 5.462864
Sun of sguared residuals = 2536.09

Standard error of the = 5.66681

idjusted R-squared -

F-statiscic (2, 78) = 50.8255 (p-wvalus < 0.00001)

Log-likelihood = -257.064

bkaike information criterion [AIC}] = 5Z0.12&
Schwarez Bayesian criterion (BIC) = 527.349
Hannan-Ouinn criterion (HQC) = 523.027

which will be explained in greater detail in chapter [Tl

8. USING THE TOOLS

Here we can find critical values from tables of the most common statistical distributions like the normal dn.,
the t-student dn. etc., with which to carry out some statistical hypothesis testing, as well as some pretty graphs of
their corresponding density functions:

Statistical tables
“m Tools |} Distribution graphs
etc.

Their use should be self-explanatory.

9. SAVING THE SESSION & EXITING GRETL

Finally, when you have finished:

“B File | Exit

You will be given the option to save the g?’ez‘/ session and, if the current data set has not been save yet, to
save the unsaved changes you may have made to it.
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Next time you want to carry on with your work from where you left it, you only have to

“T1  File » Session files » Open session. ..

...and select the one you want.

10. THE SHORT-CUTS

10.1. The Ctrl key: You probably have noticed that some of the commands described above have something like
[cuil+ ]| written at the end of its selection tab:

Tools Data  YWiew Add Sample  Yarable Model Help

Ctrl+C

Sopend data

Import »

Export data » 1. Ram712.gdt

These are keyboard short-cut combinations: you press and hold the key down while pressing also
the second key. By pressing them you reach the command destination much quicker and without the use of the
mouse.

10.2. The bottom icons: Also, you may have noticed by now that g?’ez‘/ shows some of the most useful com-
mands as icons at the bottom of the window:

Ele Tools Data View Add Sample  Wariable Model Help |

Mo datafile loaded

1D # |Variable name IDescmptwe label

¥ launch calculator

» new script

¥ open gretl console
——— session icon view
——— function packages
——b user's guide
— command reference
—— X-Y graph
— OLS model

I_' open dataset

@RAEsBEE s o

“Bl With them you may also reach some useful commands with a single click of your mouse.

10.3. A right-click of your mouse: “® Finally, clicking with the right button of your mouse on a variable name
or on a selection of variables (remember you can select more than one variable by holding while selecting),

g?’ez‘/ ’s panel will open a context window with commands like:
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Display values
Descriptive statistics
Time series plot
Frequency plot

Edit attributes

Edit values

Copy to the clipboard
Delete

Define new variable. . .

“B Clicking normally on any of them will give you the expected action.

11. OLS WITH GRETL. ..

Gretl data file h-Editorial-en.gdt| contains 40 quarterly observations from four variables: S (book Sales in
thousands of euros), P (average Price in euros), C (average price of the Competition in euros) and A (Advertising
expenditure in euros)l:

Average Average
price of  Advertising price of  Advertising
the com-  expen- the com-  expen-
Book sales  Average petition diture Book sales  Average petition diture
(Sr) price (F) () (Ar) (Sr) price (Fy) (C) (Ar)
1992:1 275.5 98.6 105.5 1868 | 1997:1 229.9 99.2 108.5 1903
1992:2 285.6 96.6 104.4 2157 | 1997:2 342.9 86.4 98.10 2489
1992:3 336.8 102.0 115.6 2541 | 1997:3 361.9 92.7 122.8 2770
1992:4 333.4 91.9 102.7 2561 | 1997:4 301.3 100.9 106.9 2493
1993:1 357.0 105.6 106.1 3103 | 1998:1 332.5 101.7 108.3 2701
1993:2 325.2 102.8 100.2 2661 | 1998:2 343.2 95.3 114.4 2497
1993:3 362.2 102.1 97.2 2757 | 1998:3 421.9 98.6 114.9 3192
‘/Ei] 1993:4 232.0 99.1 93.3 1403 | 1998:4 401.9 102.5 107.5 3086
1994:1 252.2 100.3 94.6 1856 | 1999:1 421.8 101.0 108.5 3533
1994:2 322.1 104.8 109.4 2123 | 1999:2 361.7 96.9 109.4 2864
1994:3 297.3 85.6 94.7 2181 | 1999:3 393.6 98.3 114.6 3181
1994:4 298.9 103.0 111.4 2520 | 1999:4 287.6 91.8 118.2 1855
1995:1 246.8 100.4 105.0 2134 | 2000:1 380.0 77.8 106.8 2575
1995:2 322.4 93.8 118.3 2473 | 2000:2 495.6 81.6 131.4 3723
1995:3 383.5 99.7 102.1 3125 | 2000:3 452.6 86.6 101.5 3268
1995:4 321.8 104.6 110.6 2753 | 2000:4 404.9 93.0 146.2 3025
1996:1 351.5 100.0 97.3 2869 | 2001:1 421.3 83.7 114.2 3173
1996:2 381.1 103.7 91.8 3301 | 2001:2 333.7 93.7 119.3 2387
1996:3 412.5 96.7 96.8 3043 | 2001:3 3791 94.5 116.5 2839
1996:4 2175 105.5 102.2 1538 | 2001:4 407.0 97.7 113.5 3352

You must open the data file in the usual way:

“  File | Opendata » Userfile...or J h-Editorial-en.gdt

“B If you want, you can change the names and other attributes of the variables:

“P1  Select & right-click |} Edit attributes

2As in Alonso, Ferndndez & Gallastegui’s book Econometria (ISBN:84-205-4460-4), pp. 14 & 42. Appendix B of this book, p.383,
shows full resolution of many questions related to this course that are illustrated with this data set, including the ones that follow here.


http://ocw.ehu.es/social-and-juridical-sciences/introductory-econometrics/assignments/h-editorial-en.gdt/view
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Then you can change the variable name, the description, the display name (as shown in graphs), the
compaction method (for reducing frequency using sums, averages or just a single observation per year) and the
graph line width.

11.1. Estimating a SLRM (Single Linear Regression Model).

11.1.1. Regress Sales on Price only:
St =PBo+ BB +u

(1) What sign do you expect for f3;?

(2) Plot a scatter graph of S against P and comment

(3) Run the OLS regression: do the results agree with your expectations?

(4) interpret the estimated coefficients

(5) Show that the regression line crosses the point (X,Y)

(6) What is the value of the coefficient of determination?. Interpret this value.

11.1.2. Regress Sales on Advertising expenditure only:
S; = Bo+ B2 A; +uy

(1) Repeat the process for this model, and interpret the results, etc.

11.2. Estimating the GLRM (General Linear Regression Model).
S; = ﬁO+ﬁlB+ﬁ2AI+B3CI+ut

(1) Repeat the process for the full GLR Model, and interpret the results, etc.

(2) Compare the results obtained to those from the previous SLR Models. Are they the same? Why?
(3) Obtain an estimate for the variance of the error term

(4) Table of observed values, fitted vales and residuals

(5) Estimate the variances of the estimators of the coefficients §; and 3,

(6) Estimate the covariance of 31 and [;2

(7) Plot of Sales observations against fitted values

(8) Plot of OLS residuals

(9) Plot of residuals against Price

12. CARRY ON GRETL!!...

As a young toddler I don’t think you need to know more g7e// stuff but as, alas, you grow older you will
probably want to proceed to further levels of knowledge @. In that case g?’ez‘l ’s own reference guide is conve-

niently provided with your g?‘el‘/ distribution (click on Help » User’s guide). If that proves too dense for you
(it does for most of us &) you will be happy to learn that there are several resources available in the Internet.
A search for “gretl primer” with your favourite search engine produces as a first entry an anonymous but useful
visual guide to gretl.

If you prefer something more “textbook-like” you may visitLee Adkins’ gretl page and try some of his ebooks
Undergraduate Econometricsand Using gretl for Principles of Econometrics, 3rd edition. His page contains some
additional gretl resources. Have fun! &

END OF THE PRIMER

DPT. OF ECONOMETRICS & STATISTICS (EA3)
UNIVERSITY OF THE BASQUE COUNTRY (UPV/EHU)

E-mail address: etpfemajlehu.es


http://csob.berry.edu/faculty/economics/gretlguide/GretlGuide.html
http://www.learneconometrics.com/gretl.html
http://ocw.ehu.es/social-and-juridical-sciences/introductory-econometrics/gretl/leeadkinsundergraduateeconometricsusinggretl.pdf
http://ocw.ehu.es/social-and-juridical-sciences/introductory-econometrics/gretl/leeadkinsebook3ed121.pdf
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